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Legal notices
Copyright 2008-2023 Open Text

The only warranties for products and services of Open Text and its affiliates and licensors (“Open Text”) are as
may be set forth in the express warranty statements accompanying such products and services. Nothing herein
should be construed as constituting an additional warranty. Open Text shall not be liable for technical or editorial
errors or omissions contained herein. The information contained herein is subject to change without notice.

Adobe™ is a trademark of Adobe Systems Incorporated.

Microsoft® andWindows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

This product includes an interface of the 'zlib' general purpose compression library, which is Copyright © 1995-
2002 Jean-loup Gailly and Mark Adler.

Documentation updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

To check for updated documentation, visit https://www.microfocus.com/support-and-services/documentation/.

Support
Visit the MySupport portal to access contact information and details about the products, services, and support
that OpenText offers.

This portal also provides customer self-solve capabilities. It gives you a fast and efficient way to access
interactive technical support tools needed to manage your business. As a valued support customer, you can
benefit by using the MySupport portal to:

l View information about all services that Support offers
l Submit and track service requests
l Contact customer support
l Search for knowledge documents of interest
l View software vulnerability alerts
l Enter into discussions with other software customers
l Download software patches
l Manage software licenses, downloads, and support contracts

Many areas of the portal require you to sign in. If you need an account, you can create one when prompted to
sign in.

Specifications and Limitations

Content Manager (23.3) Page 2 of 54

https://www.microfocus.com/support-and-services/documentation/
https://mysupport.microfocus.com/


Contents

Specifications 6
Introduction 6
Recommended minimum requirements 6

Main applications 7
Content Manager client (32-bit) 7
Content Manager client (64-bit) 8
Content Manager Workgroup Server (64-bit) 9

Peripheral applications 9
Content Manager Web Client Server (64-bit) 10
Content Manager Web Client Browser Support 10
Content Manager for SharePoint (64-bit) 10
Content Manager Service API 11
Content Manager WebDrawer (64-bit) 12

Integrations 12
Content Manager Office integration 13
Content Manager Zero foot print Office add-in 13
Content Manager Mobile App 14
Content Manager EmailLink email integration 14
Content Manager Kofax integration (32-bit) 14
Content Manager Warehouse integrations (64-bit) 15
Content Manager IDOL integration 15
Elasticsearch 15
ControlPoint integration with Content Manager (64-bit) 16
Structured Data Manager integration with Content Manager 16
Content Manager document viewer supported file formats 16
64-bit support 16
Other Environment 16

Relational Database Management System (RDBMS) requirements 17
Supported RDBMS servers (64-bit) 17
Minimum Requirements for database access 17
Supported RDBMS clients (64-bit) 18
Special Database Considerations 19

General 19
SQL Server database 19
Oracle database 19
PostgreSQL database 20

Specifications and Limitations

Content Manager (23.3) Page 3 of 54



Amazon RDS for SQL Server 20
Limitations and Behaviors 21

Authentication 21
Product Accessibility 21
Supported Languages 22
Installation 23
License Keys 23
Help 23
Access control and security 24
Security considerations 24
Records and containers 26
New Record forms 27

Method 1 28
Method 2 28

Searching 29
Report layouts 31
Printing 31
Content Manager viewer 32
Document Preview 33
Statistics reports 33
Action tracking 33
Dates 33
Barcodes 33
Thesaurus 34
Currency and language 34
Tagging and dragging 34
Interface 35
Locations 35
Alerts 35
Child Lists 35

Desktop integration 36
General 36
Offline Records and Content Manager Desktop 37
MS Office 38

Microsoft Office client add-in functionality 38
General 39
Compound documents 40
MS Excel 41
MS other 41
Thin Office Integration 41

Specifications and Limitations

Content Manager (23.3) Page 4 of 54



Zero Foot Print Office integration 42
MS Teams 42

Mail messaging systems 42
Microsoft Outlook 43

Content Manager DataPort 46
Content Manager Enterprise Studio 46
Content Manager Mobile App 47
Content Manager Image Scanner 47
Content Manager Render 47
Content Manager Web Client 48
Content Manager WebDrawer 49
Content Manager Workflow 49
Content Manager for SharePoint Integration 49
Content Manager for IDOL 50
Key limits 51

Data storage 51

Specifications and Limitations

Content Manager (23.3) Page 5 of 54



Specifications

Introduction

OpenText Content Manager contains powerful and useful functions for electronic document and
records management.

Because Content Manager can and should be configured in a number of ways depending on your
requirements, the functions have been designed to be flexible without compromising rigorous
document and records management standards.

Please note that Content Manager is designed to operate within the parameters of sound information
management principles and that attempts to extend Content Manager beyond these parameters will
adversely affect its implementation .

Recommended minimum requirements

NOTE: For all machines which have Content Manager components installed, it is mandatory that
the Windows® operating systems have the latest Universal C Runtimes update installed. For
additional information regarding this update, please see https://support.microsoft.com/en-
us/kb/3118401

IMPORTANT: Viewing HTML files and adding GPS location
If your organization is using Microsoft Edge browser for viewing HTML files and adding GPS
locations to objects, then for the browser to work as expected, you will need to install Webview2 at
runtime as a prerequisite. You can download Webview2 from the following URL:
https://developer.microsoft.com/en-us/microsoft-edge/webview2/.
If Webview2 is not installed, Content Manager will, by default, use the previous IE control.
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Main applications

Content Manager client (32-bit)

Component Requirement

Operating system Windows 10 (32-bit) Professional or Enterprise

Windows 11 (32-bit) Professional or Enterprise

Processor Business class processor

Memory 2 GB RAM

Disk space 2 GB free space

Sufficient space for configuration, document
caching and logging.

Display Graphics device capable of displaying a
resolution of 1280 x 768 or higher

Installation prerequisites for .msi installation Available for download:
Windows installer 5.0
Microsoft .NET Framework 4.6.2

For Web Client requirements, see Content Manager Web Client Browser Support.
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Content Manager client (64-bit)

Component Requirement

Operating system Windows 10 (64-bit) Professional or Enterprise

Windows 11 (64-bit) Professional or Enterprise

Windows Surface Pro 10

Processor Business class processor

Memory 2GB RAM

Disk space 2GB free space

Sufficient space to manage configuration,
document caching and logging.

Display Graphics device capable of displaying a
resolution of 1280 x 768 or higher

Installation prerequisites for .msi installation Available for download:
Windows installer 5.0
Microsoft .NET Framework 4.6.2

For Web Client requirements, see Content Manager Web Client Browser Support.
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Content Manager Workgroup Server (64-bit)

A Content Manager implementation must have at least one Content Manager Workgroup Server, but
may have several depending on the number of Content Manager clients and their geographical
distribution.

Component Requirement

Operating system Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a no GUI
flavour of Windows Server, is not supported.

Processor Business class server processor

Memory 4GB RAM or greater

Disk space 2GB free space for installation
Sufficient space to manage configuration,
stores and logs.

Display Graphics device capable of displaying a
resolution of 1280 x 768 or higher

Installation prerequisites for .msi installation Available for download:
Windows installer 5.0
Microsoft .NET Framework 4.6.2

NOTE: The Document Rendering event requires the Onstream printer files to process events
correctly. The required files are installed by default when using Setup_CM_x64.exe. If you're
installing Content Manager using the .msi files, theOnstreamPrinterFiles_x64.msimust be
installed as well.

Peripheral applications

Content Manager comes with a number of peripheral applications, which you can choose to install
during client or server installation, or you may need to use one of the separate .msi files from the
installation media.
Some of these have additional requirements.
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Content Manager Web Client Server (64-bit)

Component Requirement

Operating system Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a no GUI
flavour of Windows Server, is not supported.

Microsoft Internet Information Services (IIS)
Version 10.0

For IIS 10: Windows Server 2016
For IIS 10: Windows Server 2019
For IIS 10: Windows Server 2022

Content Manager Content Manager Workgroup Server

Installation prerequisite Microsoft .NET Framework 4.6.2

Content Manager Web Client Browser Support

Component Requirement

Browser Google Chrome version 108.0.5415 or above
Microsoft Edge (Chromium open source engine)
version 85.0 or above
Mozilla Firefox version 109.0.1 or above

Tablet iPad/iOS 14.1 running Google Chrome
v86.0.4240.93

Content Manager Web Client is fully responsive to a minimum screen resolution of 768px by 991px.

NOTE: The supported Office applications are Office 2021, 2019 and 2016.
The supported Office Online version is 16.0.7766.8550 and later.

Content Manager for SharePoint (64-bit)
SharePoint Online
Component Requirement

SharePoint version SharePoint Online

Microsoft Office Any version supported by SharePoint Online

Browser Edge is the browser supported when using
configuration or information pages provided by
the app. SharePoint users who do not need
these pages can use any browser supported by
the version of SharePoint.
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SharePoint 2013, SharePoint 2016 or SharePoint 2019 on premise

Component Requirement

SharePoint version SharePoint 2013 SP1, SharePoint 2016 or
SharePoint 2019

Operating system Any operating system supported by SharePoint
2013 SP1, SharePoint 2016 or SharePoint 2019

Microsoft Office Any version supported by SharePoint 2013
SP1, SharePoint 2016 or SharePoint 2019

Browser Edge is the browser supported when using
configuration or information pages provided by
the app. SharePoint users who do not need
these pages can use any browser supported by
the version of SharePoint.

Content Manager Servers in support of SharePoint 2013, SharePoint 2016 or SharePoint
2019

Component Requirement

Operating System Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a no GUI
flavour of Windows Server, is not supported.

Ancillary components Content Manager Workgroup Server
A SQL Server instance must be available on the
same or a remote computer. Supported
versions:

SQL Server 2016
SQL Server 2017
SQL Server 2019
SQL Server 2022

Content Manager Service API

Component Requirement

Operating system Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a no GUI
flavour of Windows Server, is not supported.
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Microsoft Internet Information Services (IIS)
version 10

For IIS 10.0: Windows Server 2016 (64-bit)
For IIS 10.0: Windows Server 2019 (64-bit)
For IIS 10.0: Windows Server 2022 (64-bit)

Installation prerequisites for .msi installation Available for download:
Windows installer 5.0
Microsoft .NET Framework 4.6.2

For Web Client requirements, see Content Manager Web Client Browser Support.

Content Manager WebDrawer (64-bit)

Component Requirement

Operating System Support Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a no GUI
flavour of Windows Server, is not supported.

Microsoft Internet Information Services (IIS)
version 10

For IIS 10.0: Windows Server 2016 (64-bit)
For IIS 10.0: Windows Server 2019 (64-bit)
For IIS 10.0: Windows Server 2022 (64-bit)
Role IIS Management selected

Prerequisites Content Manager Workgroup Server must be
installed with this application
Microsoft .NET Framework 4.6.2

Integrations

Content Manager integrates with a number of applications, which you can choose to install during
client or server installation, or you may need to use one of the separate .msi files from the installation
media.

Some of these have additional requirements.
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Content Manager Office integration

Component Requirement

Operating system Same as Content Manager 32-bit or 64-bit client

Microsoft Office support Office 365 (Full, installed Office on PC, 32-bit or
64-bit)
Office 2016 (32-bit or 64-bit)
Office 2019 (32-bit or 64-bit)
Office 2021 (32-bit or 64-bit)

With a 32-bit version of Content Manager client,
you must run a 32-bit version of Microsoft Office
.
With a 64-bit version of Content Manager client,
you must run a 64-bit version of Microsoft Office
.

You can run 32-bit versions of Content Manager
on supported 64-bit operating systems, and
then integrate with 32-bit Office as supported by
Microsoft.

Installation prerequisite Content Manager client (32-bit or 64-bit)

Content Manager Zero foot print Office add-in

Component Requirement

Operating system Windows 10 version 1903 or later

Microsoft Office support Office 365*

Browser Google Chrome version 108.0.5415
Microsoft Edge version 109.0

* Non O365 Office desktop, for example Office 2016 or 2019, are not supported.
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Content Manager Mobile App

Component Requirement

MobileApp l iOS 15 and 16

l Android 11 and 12

Smartphone l iPhone/iOS 15.0 /16.0 running Google
Chrome (latest version)

l Android 11 /12 running Google Chrome
(latest version)

Tablet l Android 11 /12 running Google Chrome
(latest version)

iPad l iPhone/iOS 15.0 /16.0 running Google
Chrome (latest version)

Content Manager EmailLink email integration

Component Requirement

Microsoft Exchange Server Exchange Online
Exchange 2016
Exchange 2019

Google Mail (Gmail) Gmail for Business

Content Manager Kofax integration (32-bit)

Component Requirement

Operating system Windows 10 Professional or Enterprise (32-bit
or 64-bit)

Kofax Capture support Versions 11.0 and 11 SP1

Prerequisites Content Manager client (32-bit)
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Content Manager Warehouse integrations (64-bit)

Component Requirement

Operating system Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a no GUI
flavour of Windows Server, is not supported.

Prerequisites Content Manager core libraries installed using
Setup_CM_x64.exe

Content Manager IDOL integration

Component Requirement

Operating system Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a no
GUI flavour of Windows Server, is not
supported.

IDOL support IDOL 23.2 Enterprise or OEM
Content Manager uses IDOL 23.2 OEM
for the following Content Manager
features:
— Document content indexing
—Optical Character Recognition (by
using IDOL Media Server)
— Auto Classification (by using IDOL
Automatic Categorization)
Older versions of IDOL Enterprise are
supported on principle, but they may not
support the above Content Manager
features.

Prerequisite Content Manager client (64-bit)

Elasticsearch

Content Manager 23.3 supports Elasticsearch 8.4.
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ControlPoint integration with Content Manager (64-bit)

For the details on supported versions, refer Control Point Support Matrix available at Documentation
Portal.

Structured Data Manager integration with Content Manager

For the details on supported versions, refer Structure Data Manager Certification Matrix available at
Documentation Portal.

Content Manager document viewer supported file formats

Content Manager uses KeyView 23.2 P1 Hotfix (23.2.1.8531).

64-bit support

You will find the 64-bit .msi files on the installation CD. Their file names end in _x64.

Content Manager 32-bit applications run on 64-bit operating systems; however, Content Manager
64-bit applications do not run on 32-bit operating systems.

Content Manager 32-bit clients and Content Manager 64-bit clients can connect to a Content
Manager 64-bit server.

Other Environment

Content Manager in virtual environments

OpenText Software undertakes both development and testing of Content Manager in VMWare
virtualized environments.

Where an operating system supported for Content Manager is virtualized, this should be transparent
to Content Manager; and this has been OpenText's experience to date. OpenText has numerous
customers worldwide successfully using Content Manager in virtual environments, with few or no
issues. To date, all issues that have arisen have been resolved by reconfiguration of either the virtual
host environment or the hosting hardware itself.

With regard to system performance, running Content Manager in a virtual environment is likely to
result in increased CPU utilization or other hardware resource consumption. This can result in a
reduction in system workload capacity; hence a corresponding increase in transaction response
times. OpenText strongly encourages customers and partners to gather baseline performance
statistics for Content Manager in both conventional and virtual environments, and satisfy themselves
as to the stability and performance of selected virtual environments before using them for production
implementations.

If an issue arises in a virtual environment that does not also occur in a conventional environment;
OpenText cannot guarantee a resolution to the issue. Where it is apparent that a particular issue is
specific to virtualization technologies, OpenText may ask the customer to reproduce the issue in a
non-virtualized environment before committing further support resources.

Content Manager and Citrix

OpenText neither formally test nor certify Content Manager on any version of Citrix; nor do we
produce documentation about deploying Content Manager in Citrix. It is the customer's responsibility
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to perform in-house testing in their own network environment with their own version of Citrix before
deciding whether Citrix is a suitable deployment platform for Content Manager in their organization.

OpenText Support makes every reasonable effort to assist a customer who reports an issue with
Content Manager where it has been deployed using Citrix, but we do not support the Citrix
environment itself. OpenText's past experience with Content Manager sites using Citrix suggests
that when Citrix is configured correctly, e.g. user profiles, home drives, printers etc. behave similarly
to a non-Citrix desktop environment, and Content Manager is deployed in a desktop that includes any
applications to be integrated with Content Manager, e.g. Microsoft Office suite and email, there
should not be any significant issues.

If an issue arises with Content Manager in a Citrix environment that does not also occur with a
conventional Content Manager installation, OpenText cannot guarantee a resolution to the issue.
Where it is apparent that a particular issue is specific to the Citrix deployment, OpenText reserves the
right to ask the customer to reproduce the issue in a non-Citrix environment before committing further
support resources.

For more information on this subject, see the OpenText Software Support article at
https://softwaresupport.softwaregrp.com/km/KM1456476

Relational Database Management System (RDBMS) requirements

Supported RDBMS servers (64-bit)

l SQL Server 2017

l SQL Server 2019

l SQL Server 2022

l Microsoft Azure SQL Database

l Amazon RDS for SQL Server

l Oracle 18c

l Oracle 19c

l Oracle CDB/PDB (Pluggable database created in container database)

l PostgreSQL 15.2.2

NOTE:When creating a SQL Server database for Content Manager, it is strongly recommended
that you use a case-insensitive (CI) collation sequence.

Minimum Requirements for database access

For SQL Server:

The user assigned to the database should at least have the following permission:

l db_owner

For Oracle:

The role assigned to the schema used should at least have the following permissions:
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l Alter Session

l Create Session

l Create Procedure

l Create Sequence

l Create Table

l Create View

l Create Job

l EXECUTE ON CTXSYS.CTX_DDL

l SELECT ON SYS.DBA_REGISTRY

For PostgreSQL:

The role assigned to the database should at least have the following permission:

l Superuser

Supported RDBMS clients (64-bit)

The Content Manager Workgroup Server requires RDBMS client drivers to connect to its databases.
The drivers are dependent on the type of RDBMS in use. For example:

For SQL Server, Azure SQL and Amazon RDS for SQL Server

Content Manager relies on Open Database Connectivity (ODBC) to access the databases. It is
recommended to use ODBC Driver 18.0. It can be downloaded from https://learn.microsoft.com/en-
us/sql/connect/odbc/download-odbc-driver-for-sql-server?view=sql-server-ver16

For Oracle

IMPORTANT: If you are running the process index text, bulk loading, migration, or temp table
with bulk load support, the Oracle client must be installed on the Workgroup Server that includes
the SQL Loader.
If you are using the Oracle OCI connector you cannot run an index text, bulk load or migrate from
that Workgroup Server.

NOTE: In Oracle, the CURSOR_SHARING system parameter can be set to EXACT or FORCE.
Content Manager supports both the values, EXACT or FORCE, for CURSOR_SHARING.
However, Oracle does not recommend setting the CURSOR_SHARING system parameter to
FORCE permanently.

Content Manager relies on the Oracle Call Interface (OCI) to access the databases. There are two
methods available to facilitate this:

1. By default, we include the Oracle Instant Client as part of our software. This means no
additional client software is required and the connection string will require an IP address of the
Oracle server.

2. If the user wishes to rely on Oracle’s Transparent Network Substrate (TNS), they will require a
separate Oracle Client installation (excluding the Instant Client). They will also need to setup a
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System Environment Variable on the Workgroup Server, such as follows:
Variable name: ORACLE_HOME

Variable value: C:\oracle\product\12.1.0\client_1

The variable value comes from the Oracle client’s Installation registry entry (this is dependent
on the installed environment) e.g.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_OraClient12Home1

NOTE: If you want to use different version of Oracle client than what is bundled with Content
Manager, then after installing Oracle client and configuring the ORACLE_HOME location, delete
the oci.dll located at Content Manager install folder (for example, C:\Program Files\Micro
Focus\Content Manager\).

For PostgreSQL

Content Manager relies on ODBC to access the databases. We recommend using psqlODBC. It can
be downloaded from https://odbc.postgresql.org/

Special Database Considerations

General

l Escape all special characters in search text

If you are searching using the text indexing and your search text contains any special character
(s), escape all the special character(s) in the search text.

SQL Server database

l Geographic Information System (GIS) implementation

Content Manager supports GIS data in SQL Server databases. There are no additional
installation requirements.

l For SQL Server authentication at database level, minimum required permission is db_owner
but the available databases drop down will not work at Content Manager Enterprise Studio, the
connection string can be built using cut and paste.

To use the database browsing using the drop down box, same user should be available in
master database but not required to be db_owner at master.

l BULK INSERT is not supported

If you want to get the bulk insert to function, use the Windows authentication.

Oracle database

l ANSI to Unicode conversion

The conversion to Unicode in Oracle needs either NCHAR or database character set with
Unicode support. If the database character set is Unicode supported, the conversion is done
based on the database character set which is more efficient and fast. Otherwise, based on the
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NCHAR character set provided it supports Unicode but the conversion process (converts all the
Unicode columns to NCHAR or NVARCHAR datatypes) is slower than the former.

l Geographic Information System (GIS) implementation

Content Manager supports GIS data in Oracle databases.

To facilitate this, one of the following Oracle products must be installed:
o Oracle Spatial and Graph – supports a wide range of spatial and graph analytics and has

Licence requirements. Please refer to the following documentation for more information:
http://docs.oracle.com/database/122/SPATL/toc.htm

o Oracle Locator – a free version of the basic Spatial features: Please refer to the following
link for details: http://docs.oracle.com/database/122/SPATL/oracle-locator.htm#SPATL340

PostgreSQL database

l Geographic Information System (GIS) implementation

Content Manager supports GIS data in PostgreSQL databases.

To facilitate this, the following PostgreSQL extension must be installed:
o PostGIS 2.3 bundle for PostgreSQL 9.6 (64-bit) from Stack Builder 4.0’s Spatial Extensions.
o Next, the administrator needs to enable the ‘postgis’ Extension in the database. This can be

done by either of the following methods:

n Running a script.

n Selecting a check box in the pgAdmin 4 interface.

Please refer to the following link for alternative sources and more information: http://postgis.net/

Amazon RDS for SQL Server

l Amazon RDS for SQL Server is highly compatible with later versions of Microsoft SQL Server.
As such, Content Manager works with Amazon RDS for SQL Server almost identically to a
Content Manager SQL Server implementation. Amazon RDS does have one main limitations
that change the way Content Manager works:
o No support for BULK INSERT- Amazon RDS does not support the BULK INSERT

command and so a special version of this function is provided by Content Manager for
Amazon RDS for SQL Server implementations. It provides the same functionality, however
it cannot emulate the performance of the standard BULK INSERT of SQL Server.
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Limitations and Behaviors

Authentication

l ADFS authentication and/or connecting to a Workgroup Server via HTTPS are indicators that a
user is connecting to a Cloud version of Content Manager, and in the cloud, the client computer
will not be able to access certain resources that exist in the Cloud, e.g. the URL of the
IDOL Index Server, or the file system path that is used when adding objects to a Document
Store. The time out settings on ADFS OAUTH tokens come with can also cause issues for long
running Content Manager programs, as the program gets a timeout during running and the user
cannot log again. As a result, a number of tasks on the Administration tab in the Content
Manager client will not be displayed if you are accessing the client using ADFS authentication,
or connecting to the Workgroup Server via HTTPs, or you are using Explicit Windows
Authentication.
These tasks include:
o Setup group:

n Document Stores
o IDOL Indexes group:

n IDOL Record Reindex

n IDOL Category Training

n IDOL User Reindex
o Conversions group:

n SAP Metadata Conversion

n Saved Search Conversion

n Security Filter Converter

n Mail Message Format Conversion
o Inactive Records group:

n Electronic

n Physical
o Other group:

n Import/Export

n Recalculate Disposal Dates

n Manage Thumbnails

Product Accessibility

We’re committed to developing products that are accessible to everyone. Content Manager has been
developed to be compatible with accessibility products that implement Microsoft UI Automation
(UIA) APIs.

To request an Accessibility Conformance report for Content Manager, please go to the Accessibility
Conformance Reports site.
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Supported Languages

In regards to the English language choices within our software, by design, we follow the Oxford
Dictionary which accepts the US spelling as equivalent in both languages and therefore some words
are not converted if the language is changed between English (US) and English (International), for
example Favorites.

Released Version Supported Languages

23.3 English (International), English (United States)

10.1 (multi-language).x English (International), English (United States), Dutch,
French, Spanish

10.1 English (International), English (United States)

10.0 (multi-language).x English (International), English (United States), Dutch,
French, Spanish

10.0 English (International), English (United States)

9.4 (multi-language).x English (International), English (United States), Dutch,
French, Spanish

9.4 English (International), English (United States)

9.3 (multi-language).x English (International), English (United States), Dutch,
French, Spanish

9.3 English (International), English (United States)

9.2 English (International), English (United States)

9.1 English (International), English (United States)

9.0 (multi-language).x English (International), English (United States), Dutch,
French, Spanish

NOTE: The Content Manager Web Client and Thin
Office integration only supports Dutch, French and
Spanish from 9.0 Patch 1. The CM_
ThinOfficeMultiLanguage_xNN.msi and CM_
WebClient_Languages_x64.msi cannot be installed
for the 9.0 version.
The translated language files for Content Manager
SharePoint integration will be available as a part of the
SharePoint installation MSIs for 9.0 Patch 1. You will
need to install the CM_LanguageFiles_xNN.msi after
you’ve upgraded your Content Manager SharePoint
environment to version 9.0 Patch 1.
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The translated language files for the Content Manager
client can be installed using CM_LanguageFiles_
xNN.msi to any release of the 9.0 version.

9.0 English (International), English (United States)

8.3x English (International), English (United States), Dutch**,
French**, Spanish**

* software only (documentation has not been localized)

** the language pack installers for the translated files are available on the relevant version ISO or can
be downloaded from https://softwaresupport.softwaregrp.com/ These language pack installers can
be used to install the currently supported languages to any release of the relevant version, for
example, the language files for 8.2 can be installed for 8.2, 8.2 Patch 1 etc.

Unicode support

Content Manager can manage any Unicode metadata and content, as long as the database is
configured to support Unicode characters. Without the database supporting Unicode characters,
Content Manager will regard these characters as invalid and an error message will be displayed.

NOTE: Content Manager Title and Notes word indexing relies on word splitting using spaces and
punctuation, and does not have capability to correctly index data that does not split words using
spaces or punctuation. If you’re using IDOL to document content index your Content Manager
objects, they will be indexed, but if you want to search for them you’ll need to have the appropriate
Asian language packs installed with IDOL so it can properly understand how to split the words.
For additional information about IDOL and Asian languages, refer to the IDOL Customer network
on https://softwaresupport.softwaregrp.com/manuals

Installation

l The versions of all Content Manager peripheral applications, components and integrations on
the computer have to be the same as the version and build number of the main Content
Manager application on the same computer

l When installing, upgrading, repairing or removing Content Manager applications, all
applications on the computer should be closed

License Keys

l When applying a new License Key for a pre-8.2 version of Content Manager, the Global
Settings are not retained and will need to be reconfigured and deployed after the License Key
has been applied.

Help

l F1 does not display correct Help topic on right-click menu options – when you press F1 to
display the associated help topic for a right-click menu item, the topic that appears instead is for
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the list panes and view panes, which is on the screen behind the floating right-click menu. This
is a known limitation.

l Due to the nature of the translation process, Help files in languages other than English may not
contain the latest content and in rare cases, links may not work correctly. For the latest content,
consult the Help file in an English version.

l Our own documentOurOwn.pdf is a sample document that you can replace with your
organization’s own document for users to access their own procedures using the Content
Manager Help file. The link from the Content Manager Help file toOurOwn.pdf works when
Content Manager is installed in the default folder Program Files\Micro Focus\Content
Manager; however, the link does not work when Content Manager is installed in a different
folder unless you edit the Start In parameter in the shortcut to the new Content Manager folder
path.

l The OurOwn.chm runtime merge facility has been tested to work when developed with the help
authoring tool Madcap Flare. Other help authoring tools are not guaranteed to work.

Access control and security

l Downgrading a user’s security profile – when you downgrade the security profile of a user and
they have records marked to them that are of a higher security level than the users, then no
security violation warning may appear.
For example, create a record within a Record Type which has top secret profile settings making
User the Assignee Location. User has a top secret profile. Then downgrade User to
Unclassified. The record now has an Assignee Location with a lesser security profile than
itself. However, you can use the Content Manager system option in the Security tabWhen
changing Assignee, Home orOwner for a Record to a less secure Location to set up
Content Manager to display a warning or even prevent the downgrade.

l Access Controls and record creation and default Retention Schedules - Access Control on a
Retention Schedule that is set as a default for a Record Type will not prevent users from
creating records of that Record Type if the Retention Schedule field is not on the New Record
form. Adding the Retention Schedule field to the New Record form for the Record Type will
prevent users from creating records of that Record Type using the default Retention Schedule.

l Access Restrictions and US DoD 5015.2 compliance – when Administration → System
Options → Features tab, Classified Security or Compliance tab, Implement US DoD
5015.2 compliance, or both are selected, Content Manager operates according to the US DoD
5015.2 software application design criteria standard.

Security considerations

Issue Information systems must not be susceptible to Cross-frame Scripting (XFS) attacks and
clickjacking.

Solution To avoid Cross-frame Scripting (XFS) attacks and clickjacking, add the following
<customHeaders> element inWeb.config available in your installation directory:

<customHeaders>
<add name="X-Frame-Options" value="SAMEORIGIN"/>
</customHeaders>
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Issue Internet facing Information system must implement the HTTP header HTTP Strict-Transport-
Security(HSTS).

Solution To enable HSTS, add the following <customHeaders> element inWeb.config available in
your installation directory:

<customHeaders>
<add name="Strict-Transport-Security" value="max-age=60; includeSubDomains" />
</customHeaders>

Issue Information systems must enforce controls that prevent confidential information and
Personally Identifiable Information(PII) from being stored within a persistent cookie or cached on the
client system.

Solution To address the above issue, add the following <customHeaders> element inWeb.config
available in your installation directory:

<customHeaders>
<add name="Cache-Control" value="no-store"/>
<add name="Pragma" value="no-cache"/>
</customHeaders>

Issue The X-Content-Type-Options HTTP header is a security header that is designed to protect web
applications from MIME type sniffing attacks.

Solution To address the above issue, add the following <customHeaders> element inWeb.config
available in your installation directory:

<customHeaders>
<add name="X-Content-Type-Options" value="nosniff" />
</customHeaders>

Issue CM (Service API) is Prone to HTTP DoS Attack (Slowloris)

Solution For the Slowloris attack, you can limit request attributes through the
maxAllowedContentLength andmaxQueryString attributes inWeb.config file.

Issue CM (Service API) is Vulnerable to CSRF Attacks (Cross Application)

Solution To address the issue, the attribute requireAntiForgeryToken is set to true by default.

If your application developed using our API breaks either in ServiceAPI, WebDrawer, thin office
integration, or safe guard cyber integration, then add the attribute requireAntiForgeryToken in
hptrim.config file and set the value to false.

Open the hptrim.config from either C:\Program Files\Micro Focus\Content Manager\Service_
API (Service API) or C:\Program Files\Micro Focus\Content Manager\WebDrawer (WebDrawer),
locate the <hptrim> tag, and set the requireAntiForgeryToken attribute value to false.

For example,

<hptrim poolSize="1000" highResPDFThumbnails="false" indexPagePath="~/Search"
autoPoolClean="true" ignorePropertyErrors="true" serviceFeatures="Html,Razor,Json"
xmlns="http://HP.HPTRIM.Service/WebDrawer"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://HP.HPTRIM.Service/WebDrawer hptrimConfig.xsd"
requireAntiForgeryToken="false">

Specifications and Limitations

Content Manager (23.3) Page 25 of 54



Records and containers

Containers are generally used to collect material related to a complex business transaction in order
that the entirety of the transaction can be well understood at a later point in time. As such, containers
rarely exceed 300 documents. Some customers create containers to collect similar but unrelated
documents together for the convenience of bulk disposal.

Content Manager is designed to support both of these requirements, however some limitations
become evident when creating very large containers (over 1000 documents), as some user interface
elements are built with a smaller container size in mind. For example, navigating to the contents of a
container will display the contents in descending chronological date order – this sort increases the
response time as the container gets bigger.

It is recommended to organizations that have a business requirement to create large containers that
they do not apply individual retention rules to the contents. This can lead to delays in reviewing
contents at time of disposal, particularly if you choose to archive based on an aggregated disposal
schedule.

However, if you really need to use containers with large numbers of records in Content Manager, you
can improve performance with the optionOptimize management of contained Records to allow
for very large folder sizes in the System Options - Container tab.

See Content Manager Help for more details about this option.

It is generally also recommended not to use too many container levels.
A typical implementation uses three container levels:

l Documents

l Folders

l Archive Boxes

More container levels may lead to performance degradation when Content Manager performs
recursive comparison such as checking security or retention rules across multiple aggregation levels.
Content Manager checks retention rules recursively down through a maximum of four container
levels.

l Record creation and Record Types using Numbering by Container - when you number
records by container and then change the number of the container, the contained records will
not have their corresponding record numbers updated to reflect the new container number.
Similarly, when you change the record’s container, this will not update the record’s number
either. In these circumstances, it is best to manually renumber the contained records.

l Record titles using Client titling - changing a Location name will not change any records
created using the Location as the Client title. The change will, however, be reflected in the
Properties dialog of the record; but not in the title displayed in the view or list panes. Searching
by Client Contact with the new Location name will find the record.
To manually rectify this:

1. Find any records created using the Location

2. Modify the Location name
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3. Right-click one of the records and select Properties. In the Client field, delete any Location
item and then use KwikSelect to choose the modified Location

4. ClickOK to save the change

5. The record title will change accordingly and will now show the correct Location

l Copy record - copying record relationships behavior - when Copy Relationships is selected
when copying a record, only the is Related To relationship type is copied.
An exception is when creating a new version, in which case any IsTempCopy relationship is
copied.
This is to avoid potential conflicting or incorrect relationships being created by the copy
operation.
For example, if record A has a supersedes relationship with record B and a user then copies
record B to create record C, then does record A supersede record C?

l Copy record - Date Due for Destruction and Date Inactive are not copied from the original
record when a new part, new version or record copy are performed. For a new part, Content
Manager does not copy Date Published, either.
While the process of copying a record creates a blank Date Due for Destruction field, any pre-
determined states will enter an appropriate date, for example, a Retention Schedule attached to
a record being copied, default Retention Schedule on a record, etc.

l Notes field limitation – the Notes field is limited to 64 KB (65536 characters). If a user exceeds
this limit, the message An attempt to set the Notes text to contain XX KB failed. Notes
text cannot exceed 64KB (65536 characters). The Notes text will be truncated at this
limit appears.

l Record title length limitation - When you drag and drop a record, which has record title of more
than 150 characters, from Content Manager to your desktop/folder on your system or to the
Web Client, then the record title length is truncated to 150 characters. This is because the
Windows file system has limitation of 150-240 characters, depending on the Operating System
you are using.

New Record forms

l Scroll bars - when there are more fields on the form than can be shown in the standard size
New Record form dialog box, the New Record forms will have vertical and horizontal scrollbars
allowing the users to scroll through the fields on the form.
If, however, too many fields are on the form, the dialog box may have problems displaying all
the fields.

l Mandatory container fields - when selecting Container Numbering for a Record Type, the
Record Type will automatically enter Container as a mandatory field for the new New Record
form.
However, if you change the numbering to a different type, then Content Manager does not
remove the Container field from the form automatically and therefore, you need to remove it
manually.

l Assignee Location on a New Record form filled in and then replaced - when there is an
Assignee field on a form first and there is actually a Location there that was added according to
the system rules for enclosed - that is, that require the user to set an Assignee to keep a record
from being enclosed automatically - then when a user types in a container for the record, it
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removes the allocated Assignee and replaces it with the container number.
To rectify this, you need re-assign the record.

l Enclose option - when on a New Record form, the Enclosed option will override the record’s
details and the set defaults from the Record Type or system settings

l Default Enclose? option
— will not retain its default setting in the form and apply it to a new record.
If you set up the default Enclose option for a record to No, then when you enter a container on
the form, the option details will be overwritten. Therefore, even though the Enclose option is not
selected on the form because of the default, the record will still revert to the container as the
Assignee and Enclosed? will be Yes.
— the Enclosed? behavior is programmatically selected, i.e. not configurable using System
Options. For this behavior to occur, a record’s Assignee Location must be equal to the
record’s Home Location. This can be achieved in a number of ways, for example, Record Type
Default Location or Administration → System Options → Locations tab.

Method 1

a. Record Type - Default Home Location = Blank

b. System Options - Record Assignee = Current Login

c. RecordOwner = Assignee

d. Record Home = Assignee

e. Record Details after creation are: Enclosed? = No

f. Assignee = At Home Location: User1

g. Owner = User1

h. Home = User1

i. Right-click this record→ Location → Container.
Here you will see that the Enclosed? selection box is cleared with an informative message
telling you this record is currently at Home in User1.
If you choose a container, this will become its new Home Location and the record will be
enclosed automatically.

Method 2

a. Record Type - Default Home Location = Position1

b. System Options - Record Assignee = Default Position

c. RecordOwner = Assigneed

d. Record Home = Assigneee

e. Record Details after creation are: Enclosed? = No

f. Assignee = At Home Location: Position1

g. Owner = Position1

h. Home = Position1
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i. Right-click this record→ Location → Container.
Here you will see that the Enclosed? check box is cleared with an informative message telling
you this record is currently at Home in ***.
When you choose a container, this will become its new Home Location and the record will be
enclosed automatically.
When you change the Home Location, then the Assignee will keep the default Assignee
Location from the Record Type.

NOTE: The Associations of a Location only go up one level. You can make the parent
Organization the default, for example, in the following hierarchy structure; Parent Organization -
Child Organization - Position – Person.
The default Organization for Person will always be Child Organization unless you manually make
Parent Organization the default.

On a New Record form, when a user has explicitly changed the value of an Additional Field that has a
default value determined by the record Classification, and then changes the Classification, then
Content Manager does not change the Additional Field's value to the value determined by the new
Classification

Searching

l Classification Word searches – when you enter one word, it means find records whose
attached Classification contains the word

NOTE:When you enter many words, it means find records where the attached classification
contains all the words

When you type a wildcard character (*), it means find records where the attached
classification contains a word matching the wildcard character

When you type a wildcard character and one or more other words, it means find records where
the attached classification contains a word matching the wildcard and contains all the
other words as well

l Record Number Range searches – this search method is a simple string search method that
searches alphabetically for the values you entered, whether they are numbers or letters.
Therefore, it is essential that you know the record number pattern of the records you are looking
for.
For example, when you enter a search for records in the compressed number range from
1998/1 to 1998/100, Content Manager does not return record 1998/50, because alphabetically,
it is not within the range you specified.
Workaround: When searching for a range of records using Record Number:
o use the KwikSelect on the To and From fields to select valid Content Manager record

numbers, rather than typing the numbers in.
o when manually entering record numbers into the TO and FROM field ensure that the record

numbers are validated (goes bold)
o use expanded Record Numbers in the To and From fields
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o use the Expanded Record Number search method (Numberx) as this search method
validates the numbers that are entered into the To and From fields.

l Sort order of container content – subordinate items under a container that you expand with the
plus symbol are not sorted according to the criteria the container is sorted by, but by a default
field. For example, records under containers are sorted by Date Registered in descending
order.
Workaround: Right-click the container record and click Contained Records to see the
container content in a separate search window, where you can sort the records as you require.

l When Automatically count results where possible on the File → Options → Search
Options tab is selected, and the user experiences delays with Content Manager returning their
search results, turning off this option may improve performance

l TheGo Back button executes the previous search result again and replaces the current search
result

l Content Manager applies the default sort order and filters only to new searches, i.e. from the
Searchmenu or the Search pane, but not, for example, to searches using the Location
Show,or Classification or Hold Show Records commands

l The IDOL search engine is designed to return a fixed number of items. The default value for
Content Manager searches that use the IDOL search engine is 100,000.
The upper limit for MaxResults is 10,000,000. Any IDOL search or combined IDOL / metadata
search that includes a Content query that exceeds the limit set by MaxResults may return
inconsistent results.
You can change this figure by changing the IDOL configuration files. In Content Manager
Enterprise Studio Help, see the topic Advanced configuration of OEM IDOL about the
parameterMaxResults. Setting the MaxResults value to the maximummay impact on the
overall search performance of your IDOL and hybrid IDOL/Metadata queries.

l Saved Searches – due to the design changes made in the Search module in Records Manager
8.0, Saved Searches that have been created in TRIM 7.3x will not work in Records Manager 8.x
and Content Manager after upgrading.
A Saved Search Conversion utility has been added to the Administration menu in Records
Manager 8.11 and is available in 8.11x or later. Administrators can run this utility to convert old
versions of Saved Searches into the correct format for Content Manager. Depending on the
complexity of the Saved Searches, the conversion may not be successful. In particular, Action
Tracking saved searches and Communications saved searches are not converted the 8.11x or
later version of conversion utility. Searches that fail to convert are left as “old format” searches
in the system. It is recommended that organizations document their Saved Searches before
upgrading.

l By design, when an existing Saved Search is overwritten, the Active Audit Log will show that
Saved Search was Deleted and a new Saved Search is added.

l Record Number Range Search - the Record Number range search method is a string search
and as such there is no validation on the numbers that are entered/selected in the To and From
fields. The results returned from running a range Record Number search may be unexpected as
there is no validation done on string searches.
Workaround:
When searching for a range of records using Record Numbers, use the Expanded Record
Number search method (Numberx), this search method validates the numbers that are entered
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into the To and From fields. It is also recommended that you use the KwikSelect on the To and
From fields, rather than typing the numbers in.

l Saved searches that used IDOL specific query syntax are not supported when using
Elasticsearch content index. IDOL keywords IN, PARAPGRAPH and NEAR10 are not
supported, e.g.:
o Fiona IN MsgAttachment to match "Fiona" in Email attachments
o Fiona PARAGRAPH Dugong to match matching "Fiona" in the same paragraph of text as

"Dugong"
o Fiona NEAR10 Chris to match "Fiona" within 10 words of "Chris"

Additionally, explicitly using IDOL field names is not supported, eg {text}:DRECONTENT, but
can be replaced with equivalent Elasticsearch field names (Content:text)

Saved searches created using IDOL specific query syntax must be recreated when moving to
Elasticsearch content indexing.

Report layouts

l The thickness of a line in a report layout can be controlled, but not the thickness of lines for
rectangular boxes

l The option Print Alternative Barcode? in the report layout barcode item properties dialog box
prints the expanded record number and therefore, applies only to record barcodes, not Location
barcodes

l To print more than one page of notes or Additional text Fields for a record, a report requires
them to be the last active item in the Band Definition list.
Its height must be greater than 1 line so that it may automatically (dynamically) increase
vertically to display all the data in the field.

l If the report layout contains more than one text field, for example, both Notes and an text
Additional Field, the field text area in the report band may expand over other fields in the report,
making them illegible. The issue does not occur for the last field in the report band or when the
number of characters and/or the font size are small enough to fit all text in the text field area.

l Users in the same Content Manager session cannot open the same report more than once
simultaneously

l Users in different Content Manager sessions, for example on different computers, can open
and modify the same report. However, only the last modification saved is retained and the
administrator will receive a mail notification informing them that the document store could be
corrupted.

Printing

l When printing items whose file type is set to Bypass Viewer, Content Manager does not
display a confirmation dialog.
When bypassing the internal Content Manager viewer, you are printing from the associated
application. For example, when Bypass Viewer is selected for Word documents, clicking File
→ Print in Content Manager prints the document. When Bypass Viewer is not selected, the
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viewer handles printing and Content Manager displays a confirmation message in case you
have clicked Print by accident.

l Printing a specific page of a report is not supported in Content Manager. For example, if you are
printing a large multi-page report and the printer has a paper jam, it is not possible to select a
page or a range of pages to reprint. Instead, you need to print the whole report again.

l When you print a Word document or an Excel spreadsheet from Offline Records, Content
Manager opens Word or Excel to print. The same behavior occurs when you right-click to print a
Word document or an Excel spreadsheet from the desktop or Windows Explorer.

l Some documents may take longer to print than others, such as large graphic files, or produce
corrupted print. For best printing results, use the original application for printing large and
complex image files where possible. The Content Manager image viewing software is designed
for generic viewing and does not produce the same viewing results as the authoring application.

l Printing reports - when selecting a different printer to print a report, Content Manager uses the
same settings as for the previous printer. KnownWindows limitation.

l Users may experience long delays when viewing or printing MS PowerPoint files from Content
Manager. As a workaround, it is recommended that they add the MS PowerPoint file
extensions, PPT and PPTX, to the Bypass Viewer for these document types option on the
Options - Viewer tab.

l If the EML file type has been added to the Bypass viewer for these file types list (Options -
Viewer tab) and the user attempts to print an EML type electronic document using the right-
click Send To - Print Document option in Content Manager, it will fail to print.
Workaround: Remove EML file type from the Bypass viewer for these file types list, or open
the EML document in it's native authoring application and print from there.

Content Manager viewer

l When viewing PPTX file in Content Manager Viewer where PPTX document content format
changes when previewing in Content Manager Client or printing PDF rendition.

Workaround

Add theGraphicFontScale parameter underOptions section in the formats.ini located in the
Content Manager install folder (e.g, C:\Program Files\Micro Focus\Content Manager\)and
restart the Content Manager client.

For example, GraphicFontScale=0.5

l KeyView provides different levels of support for different file formats:
— Viewing
— Filtering (the ability to extract text)
— Exporting (the ability to convert the file to HTML or XML format)
—Metadata extraction
— Detection (ability to detects its format)
Not every file format is supported for every level. This is a known limitation of a third-party
product.
To use a localized version of the viewer, users should have the permission Full Control to the
Windows Program Files folder.
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l When an email message contains information that is stored in a location inaccessible for the
Content Manager viewer, for example a signature on a secure Internet site, Content Manager
viewer may not be able to display the entire message, and cannot apply retention business
rules or store the remote part of the message.

l Unicode file names were handled incorrectly when performing text extraction from preview and
View (517108).

Document Preview

A record that has an attached electronic document that is over 25 MB in size will not be automatically
displayed in the View pane Preview, Previous or Rendition tabs on a record search results window
for performance reasons.

Workaround
If a user wants to preview the current rendition of the document, they can right-click on the record and
click View.
If a user wants to view a rendition or previous revision of the document, they can right-click on the
record and click Properties. On the displayed Properties dialog, click on the required tab e.g.
Revisions or Renditions and then view the document.

Statistics reports

l Actions deleted from Content Manager that were attached to a record before remain in the
KwikSelect → Action name list

l Record statistics reports cannot generate or export statistics if Microsoft Excel is not installed
on the computer.
Microsoft Excel components are used to export the statistics report details.

Action tracking

l Assigning a Procedure with a Start Datemay generate a Start date must not be before
message if the regional settings on the PC have the time set for 12 hour time but no designation
for AM or PM.

l When attaching an Action to a record with the option After any Existing Record Actions for
this Record, Content Manager will start this Action after the completed Actions’ Due date, not
their Completed date.

Dates

l Content Manager supports any valid Gregorian date, back to the year 100.
Content Manager converts years from 30 to 99 to a four-digit year in the 1900s, and a year from
0 to 29 to a year in the 2000s.

Barcodes

l Foreign barcodes that contain non-printable characters are not supported, for example, tab etc.

l If a user does not have Can Use access to a particular Location, they will not be able to change
the record’s Assignee Location using a barcode scanner

Specifications and Limitations

Content Manager (23.3) Page 33 of 54



Thesaurus

The Content Manager Thesaurus has been designed to follow the recommendations of ISO 2788 -
Guidelines for the establishment and development of monolingual Thesauri.
While every term may have as many narrower terms as a user may require, a well-designed
Thesaurus will have an appropriate number of subordinate terms, typically to a maximum of 10 to 15
terms.

l Thesaurus terms cannot contain hyphens (-).

Currency and language

l The default currency symbol set in the System Options → Currency tab only allows one
system-wide default to be set up

l French Date Received Additional Field and checking in email - when checking in an email
message, the Date Received Additional Field of type date or date/time will be populated under
all available language variations. However, for the French version of Date Received (Date de
Réception), the accent must be used in the label of the field for it to function.

l Changing the caption of a field in Content Manager changes it in all interface languages

Tagging and dragging

l If you are performing a task on some tagged records which causes some of the tagged records
to no longer fit the search criteria for the window, then press Refresh before performing any
additional tag processing, for example, reporting, retention etc.

l Dragging messages to a linked folder in Outlook - Content Manager may not automatically
process large numbers of items when dragged to a linked Outlook folder.
When a mail message is added to a Linked Folder in Outlook, an event starts.
There is a limitation on the number of items that can be dragged to a folder in Outlook and still
start this event, they may not all be checked in to Content Manager and error messages may
not appear. The items will, however, be added to the selected folder.
When there are unprocessed items in a linked folder, it is recommended you use the Clear All
Backlogs option, to process the unprocessed items in all folders, or Clear Backlogs to
process just the items in the selected folder. These two clear options are accessible from Check
In Styles panel in Outlook.

l When dragging and dropping an email onto Content Manager a different MSG file is produced
compared to those that are checked in via the Outlook integration. As a result, if the Check for
duplicate email messages option is enabled, a warning will not be displayed if an email is
checked in twice but via different check in methods.

l When a user drags and drops the same document in quick succession, if the Record Type has
the Behavior for Duplicate Titles set to Display Warning or Prevent, the warning/error
stating that there is a duplicate titled record will not be displayed as Content Manager has not
completed the Word Indexing for the first document. The user must wait for the first document to
be indexed before a duplicate title check will work.
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Interface

l Some field values appear differently depending on whether they are in a column or in the View
pane. This is because of the differing amount of space available to display the values.

l Custom toolbar icons – Content Manager does not support the creation of user drawn toolbar
icons. A wide selection of predefined icons is available.

l Status bar - staff name display - in online mode, the staff name is obtained from the Location’s
display name. In offline mode, the staff name is obtained from a Location’s network login.

Locations

l It is recommended to limit the number of staff members allocated to work areas or units to 80 to
100 at each level which enables Content Manager to sort, display and refresh the screen at an
acceptable performance level.
If the number of Locations exceeds this guideline, customers should enable the Content
Manager system option Administration → System Options → Object Cache tab →
Optimize Performance of → Location Member Of Relationships.

l Special characters in Location names limitations:
— The percentage character (%) is supported, but may cause some inadvertent search results
in Location searches
— The asterisk character (*) is supported but may cause confusion as it is used as a wildcard
search character

l Location properties Associations tab – Content Manager does not support changing the order
ofMember Of, Supervised By and Delegate Of. TheMove Up andMove Down options are
only available for the Has Members, Supervisor Of and Has Delegate items.

l Default Location cannot be changed to regular – in the Location properties Associations tab,
when an association type has only one Location, Content Manager makes it the default. To
change its status to regular, make another Location of the same association type the default
first.

l User cannot choose between multiple email templates for the same mail event type – if there
are multiple email templates for the same mail event type, Content Manager will use the first
one according to its name to create an email notification for the event. Users cannot choose the
one to use. Workaround: Create only one email template per event.

Alerts

Due to the design changes made in the Alerts module in Records Manager 8.1, Alerts that were
created in previous versions of Content Manager and TRIM are removed as a part of the upgrade
process and will need to be manually redefined in Records Manager 8.1 after upgrading.

It is recommended that all Alerts are reviewed and documented before upgrading to Records
Manager 8.1. This will assist you in recreating the Alerts after upgrading.

Child Lists

A limit of 100 items applies when creating child lists, for example, a warning will be displayed if more
than 100 Contacts are added to a record. The exception to this limitation is the record Relationships,
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e.g. Related To, Parts etc. child list, where the total limit is 1000 items, but only 100 items can be
applied in a single transaction.

Desktop integration

l Password protected files - password protected files (that is, the password added in authoring
application) are not supported. Password protection can cause problems with several facets of
Content Manager operations.

NOTE: Deactivating password protection does not necessarily reduce the security problem
because a prime purpose of a professional enterprise content management system is to provide
storage, retrieval and security for all registered files.

General

l Unlocked files - apparent check in discrepancy - certain applications do not lock files when in
use, for example, WinZip, which means in turn that Content Manager cannot determine whether
the file is in use.
In certain circumstances, for example, when a user modifies a *.zip file after it has been
checked back in - see steps below, this may result in multiple copies of the file.
Where applications do lock documents in use - for example, Word - check in is disallowed in
Offline Records.
For example:

a. Right-click and select Edit to edit a *.zip record, for example, Test.zip, which checks out the
document for editing using Content Manager Desktop.
Content Manager automatically checks the document back in when you close the document or
authoring application. Before modifying the document or closing the application or document,
open Offline Records standalone and check in the *.zip file

b. In the authoring application, modify the *.zip file

c. Close the document and authoring application.
The record in Content Manager has the original document with the original contents and a new
draft document has appeared in Offline Records with the modified content.
This is the same behavior as when you delete a *.zip file fromWindows Explorer while editing
the .zip file using WinZip.

l Checking in multiple documents using right-click Send To fromWindows Explorer may result in
the Windows error messageWindows cannot access the specified device, path, or file.
You may not have the appropriate permissions to access this item. - known limitation
caused by Windows, not limited to Content Manager.
Workaround: Send smaller file groups instead.

l Document queues – sub-folder processing not supported. The document queue processor
does not process items in sub-folders. Instead, you will need to create a separate queue to
process this folder.

l Keyboard shortcuts for Microsoft Office 2010 applications other than Word and PowerPoint
may not work as expected when integrated with Content Manager. This is due to limitations of
those Microsoft Office applications.
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l When Content Manager is integrated with MS Office and MS Outlook, whether using the client
integration or using the Thin Office integration, by default a folder is created in the local user
directory C:\Users\<your user>\Documents\OpenText CM If this directory has it's security
locked down for users they cannot save records through the integrations.
Workaround: In the Office Integration's Preferences file, which is added to the
C:\Users\<username>\AppData\Roaming\Micro Focus\Content
Manager\OfficeIntegration directory when the Office integration is opened, there is a property
calledMyDocumentsFolder. If a value is defined for this property, it will be used as the root
path for the CM folder. If the property has no value, then the user'sMy Documents folder will
be used.
The properties of the Preferences file can be defined and the file installed as a part of a network
installation process for Content Manager.

Offline Records and Content Manager Desktop

l The option File > Options > Search Options tab > Automatically view electronic
documents is not supported for Content Manager Offline Records.

l Offline Records in offline mode and Container icons - when a user checks out a container
record to Offline Records, the record uses the icon of the Record Type at the time of checkout.
If the icon changes in Content Manager, it is not reflected in Offline Records until the record has
been checked back in and then back out to Offline Records.

l Offline Records file path lengths – maximum lengths supported by applications - different
versions of Office and other applications have different file path length limits.
When a user saves a document in Offline Records, the maximum number of characters is
determined according to the application limit. The document name will be truncated at whatever
it needs in order to not exceed the applications total file path length limit.
For example in Excel, the file path length is set at 201 characters including the full Offline
Records path, such as C:\Documents and Settings\user\My Documents\Offline Records
(03)\folder name\document name.xls.

l AutoCAD 2005 - when an AutoCAD 2005 file is saved to Offline Records by clickingMy Offline
Records in the Save In box, double-clicking Offline Records does not open Offline Records.
Workaround: Click the Save button to first open Offline Records and then the file can be saved
to Offline Records.

l Offline Records andMy Documents folder set as a shared folder – it is not recommended for
organizations to configure their environment so that theMy Documents folder is a shared
network resource, as Content Manager Offline Records will not work as designed, which is as a
resource when there is no network access

l Offline Records and Microsoft Word file names - in MSWord, the file names include the path as
part of the file name and are limited to 256 characters. This is a MSWord field length limitation.
Therefore, when you attempt to save a file using Offline Records and you make the file name
too long, Word truncates the name to fit the 256-character limit.

l Upgrading of an older version of the TRIMTD.mdb file is not supported

l When you apply global settings, Content Manager resets offline folders to system default
settings
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MS Office

Microsoft Office client add-in functionality

You can use Content Manager add-ins in Microsoft Office applications. The tables show the
applications and the Content Manager add-in commands they support:

Office 2013 SP1(32-bit and 64-bit)

Feature Word Excel PowerPoint Project

Open Yes Yes Yes Yes

Save, Save As Yes Yes Yes Yes

Record Properties Yes Yes Yes Yes

Make Final Yes Yes Yes Yes

Insert Picture Yes Yes Yes No

Insert Object Yes Yes Yes No

Insert Text from File Yes No No No

Office 2016 (32-bit and 64-bit)

Feature Word Excel PowerPoint Project

Open Yes Yes Yes Yes

Save, Save As Yes Yes Yes Yes

Record Properties Yes Yes Yes Yes

Make Final Yes Yes Yes Yes

Insert Picture Yes Yes Yes No

Insert Object Yes Yes Yes No

Insert Text from File Yes Yes Yes Yes

Office 2019 (32-bit and 64-bit)

Feature Word Excel PowerPoint Project

Open Yes Yes Yes Yes

Save, Save As Yes Yes Yes Yes
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Record Properties Yes Yes Yes Yes

Make Final Yes Yes Yes Yes

Insert Picture Yes Yes Yes No

Insert Object Yes Yes Yes No

Insert Text from File Yes Yes Yes Yes

General

l Set GPS location - There is a known Internet Feature Control issue with loading the Google
Maps API from Microsoft Office and Outlook. To resolve this issue and be able to set the GPS
location for a record or a location using office integration, you need to create the following
DWORD (32 bit) registry keys with the decimal value 69633 at the location \HKEY_CURRENT_
USER\SOFTWARE\Microsoft\Internet Explorer\Main\FeatureControl\FEATURE_
BROWSER_EMULATION:
o excel.exe
o OUTLOOK.EXE
o powerpnt.exe
o winproj.exe
o winword.exe

l For Microsoft Office 2013, if you have added the Content Manager web server URL from
System Options > Web services page and trying to drag and drop a Content Manager record
with electronic document using the right mouse button to any of the Office 2013 application
does not give youMove, Copy or create Hyperlink Here options.

l Default file types for integrated Microsoft Office applications
— Excel - uses the default file type set in Excel when it is xls, xlt, xlsx, xlsm, xlsb, xltx, xltm.
When the default is different, Content Manager uses a default of xlsx in for Excel 2013 and
2016.
—Word - uses the default file type set in Word when it is doc, dot, docx, docm, dotx, dotm.
When the default is different, Content Manager uses a default of docx for Word 2013 and 2016.
— PowerPoint - pptx for PowerPoint 2013 and 2016
— Project -mpp for all versions

l Conflicts of Content Manager Microsoft Office add-ins with 3rd party add-ins – Content
Manager Office add-ins with the Office File – Close and File - Save commands. While
OpenText does not anticipate conflicts, nor have received reports of conflicts, there is a
theoretical chance that a 3rd party add-in that also works with these commands may conflict
with the Content Manager add-in.
The Content Manager Office add-ins for MS Office 2013 and onwards do not work with these
commands, as they uses a different operating model. As a result, the chance of conflict is
reduced.
Customers should thoroughly test their add-ins in operation with Content Manager add-ins to
identify possible issues before running the add-ins in a production environment.
Workaround when conflicts arise: By using an MS Office custom property, users can turn the
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Content Manager add-in for the MS Office applications Word, Excel, PowerPoint and Project on
and off, depending on when they need to use the add-in functionality. For instructions, see the
Tech Note at https://softwaresupport.softwaregrp.com/km/KM00640635

l In an Windows 8+ environment, printing Content Manager records (electronic documents) can
only be done from the MS Office authoring application File > Printmenu options. If a Content
Manager document is being viewed in the Content Manager Office integrationOpen dialog,
printing using the Content Manager Print Document option is not supported.

l Documents checked into Content Manager from MS PowerPoint or MS Project will appear in
the application's native Recent documents list even though they have been removed from the
users hard drive. If selected, the user will see a native message.
In MSWord and MS Excel the file names will not appear in the native application's Recent
documents list.
Workaround: To access a Recent Document that has been checked into Content Manager, the
user can open it from the native application's File > Open > Content Manager > Recent
Documents option.

l Dragging and dropping documents directly from Content Manager into other applications, for
example Trapeze, is not supported.

Compound documents

l Compound documents and email – Content Manager does not detect compound documents
when checking in from supported email clients MS Outlook

l Compound document renditions – the Renditions function does not recognize compound
documents that are record renditions

l Broken links when viewing – after check in, compound document link is broken when viewing in
Word or the browser plug-in - Windows limitation

l When a user checks out a document to Offline Records and then edits the actual document, not
the link, checks in the document using the Replace Current Revision orMake a New
Revision commands and then right-clicks it and views the document using the associated
application - Word - or the browser plug-in for the viewer, the link reads Error! not a valid link.
If the viewer is the Content Manager viewer, the link works correctly, as Content Manager does
not alter a document.
In Microsoft Word (Edit > Link), the link appears as incorrect because it is pointing to the path
to Offline Records, rather than to the folder where the document actually is.
When you first check out the document and open it, the Edit > Links function in Word displays
the path to the folder where the container document is - the Offline Records folder. When you
edit or update the link, it displays the correct folder path.
If, however, you make changes to the container document and do not edit the link, Content
Manager uses the local Offline Records path when you check the document back in, rather than
the folder path.

l Excel spreadsheets in Word documents – in Word, when trying to save the document while the
Excel spreadsheet is active, an error message may appear. This is due to the way Microsoft
Excel add-ins operate.
Content Manager does not detect that Word is the parent application until the user deselects
and then reselects the Excel object.
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l Compound documents with broken links - if the path to a linked document does not exist or is
not resolvable, Content Manager does not detect a link at all.
If Content Manager cannot read the linked document, the link defaults to External To Content
Manager.

MS Excel

l Excel and date formats - when opening and re-saving tab delimited or comma delimited files
into Content Manager using Content Manager integration, ensure that date fields are set to
Text format to avoid Excel ignoring the date format of the operating system and using US date
format.
You can find more information in the Microsoft Knowledge Base article explaining Excel’s
handling of date formats: http://support.microsoft.com/kb/214233

l Excel Share Workbook function – Content Manager supports editing of a shared workbook
only when the workbook is checked out of Content Manager to Offline Records or edited as
supercopy.
Using the Edit option in Content Manager does not check out the workbook. To edit a shared
workbook use the Check Out and Check In options.

l Multiple installed Excel add-ins on one computer are not supported • Microsoft Excel will not
allow a custommenu item like the Content Manager Save, Save As andOpen commands be
used if there is a change made in a cell and the user has not committed the change by moving
out of the cell.

l Excel and Project document's - the local file does not get deleted when application is closed
using X button:
o If you close the application using the X button, the leftover local file will not be deleted from

the Offline/Microfocus Content Manager folder.
o In case multiple Content Manager documents are opened in office application and you

close the application using X button then all the leftover files will be deleted except for the
last one. The leftover files are deleted when the file is closed using the File > Closemenu
option.

o When you start the office application again, the add-in deletes the leftover files.

MS other

l Microsoft Binder - Content Manager cannot document content index text within Microsoft Binder
files

Thin Office Integration

l Microsoft Project – selecting an existing Microsoft Project Template (.mpt) file using theOpen
option will cause a new project to be created based on the selected template, rather than
opening the template file for editing.
This follows the native behavior of Microsoft Project which does not support editing an existing
template file.
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Zero Foot Print Office integration

l With the Zero Foot Print Office integration, particularly Excel and PowerPoint, if the user clicks
on the Save button multiple times without changing the content, then the record revision may be
incremented in Content Manager.

This occurs because Microsoft 365 changes the metadata associated with the document giving
the impression that the document has changed which causes the increment to the record
revision. With the available APIs from Microsoft we cannot reliably tell if the document content
or just the metadata has changed. This behavior will be reviewed in a future release.

l If user searches for records and without clicking a specific record, clicks onOpen button, it
opens earlier selected record (732073).

MS Teams

l Checking In more than 75 records - Application throws a Request failed with status code 404
error when you try to Check In more than 75 records.

l Select All with filter In Content Manager - If you have selected Select All option with In Content
Manager filter and click on a folder where the files within that folder are not checked in at all,
then a Cannot read properties of null (reading 'Name')" error is displayed.

l Same record number and incorrect record revision - For the chats, when you select Select All
option to check in multiple files, then after checking in, the records display same record number
with incorrect record revision (741118).

Workaround - Refresh the page to see the correct record number and revision.

l Search throws an error if user does not have access to some of the object(s) (712084).

l Filtering MS Teams content using Not in Content Manager option is not working as expected
(722033).

l Visual indicator shows that server side filing is enabled for all datasets even though it is enabled
for just one dataset (712099).

Mail messaging systems

The email format checked into Content Manager is dependent on the integration being used. The
email formats captured are what the mail system can provide:

Email Integration Captured File Format

Outlook integration MSG

Thin Outlook integration MSG as the native file output from MS Outlook

EmailLink integration EML as there is no MS Outlook interaction to convert
to MSG

l Embedded email messages are treated as attachments in Content Manager. Content Manager
considers email messages that are embedded in an email message to be attachments.
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l Date sent details - date sent information is stored for Extended MAPI compliant applications.
Simple MAPI does not provide send date information.

l Email and BCC recipients - it is possible for an email message to be sent that only has BCC
recipients.
In some cases, this can result in the email not actually being delivered because some SPAM
filters will not permit email in where the only recipients are BCC addresses.

l Microsoft Exchange support – while Content Manager does not work directly with Microsoft
Exchange, testing does include Microsoft Exchange and Outlook versions supported by
Microsoft. However, as there are several versions of Microsoft Exchange and Outlook, as well
as many possible Content Manager configurations, it is highly recommended that before
upgrading your Microsoft Exchange servers, you undertake thorough testing in your software
environment to ensure there are no issues.

Microsoft Outlook

Microsoft Outlook client add-in functionality

Function Microsoft Outlook (32-bit)

2013 SP1,
2016

Microsoft
Outlook
(64-bit)
2013 SP1,
2016

Checking in to Content Manager Yes Yes

Checking in automatically from folder Yes Yes

Checking in on send Yes Yes

Content Manager email notification Yes Yes

Content Manager File/Send Yes Yes

Content Manager mail messageform/send Yes Yes

Attach Content Manager record to new message Yes Yes

l Outlook linked folders –
o Dragging an email to linked folder - the Outlook integration has a known limitation on

some mail servers which causes an error when dragging an email to a linked folder.
o Sent Items folder - it is not possible to make a link to the Sent Items folder to capture all

outgoing messages.

The Sent Items - Content Manager folder is linked as a managed folder internally by the
Content Manager Outlook integration. It has unique functionality for items that are added to
its collection. The user can selectively check in an item sent by them rather than all items
sent from their account. This will avoid noise emails from being checked into Content
Manager, giving users the control to selectively add their mail to Content Manager.
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If all items sent from an account are to be checked in, we suggest using an Inbox rule that
copies them from the Sent Items folder to another folder which can be linked to Content
Manager.

l Outlook - Content Manager Send To and signature blocks - there are many instances where
the signature block is not included in an email, for example, Explorer > Send to > Mail
Recipient or Word > File > Send to > Mail Recipient.
This is due to the function requesting a blank Outlook form. To resolve this, when the form
appears, choose Insert > Signature.

l Date and time properties of the actual email sent or received differ to those displayed in the
Content Manager viewer. Content Manager rounds down the time to the nearest minute, while
Microsoft rounds up to the nearest minute. Therefore, the email time details in Content Manager
will differ from the actual email time by a minute.

l Outlook email messages and document content indexing - when you check in an email
message that was saved locally in .msg format or embedded emails sent to Offline Records,
Content Manager saves them as .msg files in Content Manager format.
Content Manager indexes their content if that functionality has been applied to their Record
Type.

l Outlook Send To option - when Content Manager in Outlook is enabled and a user selects
Send To from another application, the message will be in the Outlook Outbox untilOutlook is
opened and the mail client is connected to the server.

l Check in on send is not supported when the Outlook option Save Sent Items is not selected.

l As Microsoft does not store the message id on sent Outlook items, items that are checked in on
send are not checked as duplicates if the System Option - Email Records tab - Check for
duplicate email messages is enabled.

l Simple MAPI is not supported for Outlook

l Outlook and Avaya Unified Messenger – the Avaya Unified Messenger and Content Manager In
Outlook add-ins co-exist in Outlook; however there is no Content Manager interface with
Unified Messenger itself. That means, when using Unified Messenger, there is no Content
Manager functionality available.

l Outlook - managing Content Manager linked folders and public folders on the Exchange Server
– when you have multiple users linked to the same public folder on the Exchange Server and to
the same Content Manager database then when one person drags an email to the linked folder,
all the users that have that folder linked will see the same dialog boxes as the person who is
checking in the email message.

l Outlook public folders known limitation - at times, an automation error may occur when
attempting to check in from a public folder Inbox. However, when you open the email first, you
can check it in without the error.

l If the SQL database does not allow for Unicode characters, then after checking in an email
message, Content Manager replaces Unicode characters in the email subject line with other
characters or question marks (?).

l The Outlook 2013 setting Cached Exchange Mode affects the MAPI document browser.
When the setting is not selected, Content Manager document queues of type Extended MAPI
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Folder do not display or process the email messages in the Process Document Queue
window folder when clicking Process to process the queue.
Workaround: In Outlook Account Settings, double-click the account. UnderOffline
Settings, if you need to keep Cached Exchange Mode selected, use the slider to change the
setting forMail to keep offline.
Content Manager processes all the mail that falls within the period selected here.

l Email items that have their Sensitivity set as Private and are checked in using the Content
Manager Outlook Integration are unable to have their subjects modified and will not have CM
prepended once they’ve been checked in. This cannot be rectified. A message will be in the log
describing the behavior:
"Information: Unable to change the subject of a checked in item. This item's subject will not be
suffixed with CM. Details: The object does not support this method."
All other Sensitivity types (Normal, Personal or Confidential) should be prepended with CM:
Subject

l In Cached Exchange Mode, items that are marked Check in on Send will be checked into
Content Manager without a Message ID. This behavior is due to Exchange saving a copy of the
email that has not yet had an Internet Message ID assigned in the Sent > Content Manager
folder in MS Outlook.
If a recipient of this email checks in the received message and Content Manager is checking for
duplicate email messages, it will not trigger the duplicate warning, as the Message ID is used to
determine duplicate emails. Subsequent recipients will not be able to check in the email as the
email will have been assigned a Message ID.

l Users that are using multiple Outlook environments must ensure that their profile name
matches in all environments otherwise their Linked Folders will not work correctly.
Workaround: Users will need to re-create their Outlook Profile on the machines it does not
match on.
o Close Outlook, open Control Panel and selectMail.
o When theMail Setup - Outlook dialog opens, select Show Profiles...
o Remove the profile that is not correctly named, clickOK.
o Open Outlook.
o The New Profile dialog will display, enter the correct name of the profile and clickOK.
o The Add Account wizard will appear. Set up Outlook.
o When Outlook opens, select Content Manager > Check In Styles
o The list of Check In Styles will display. Any Linked folders that display an incorrect profile in

theOutlook Folders list will need to be removed and re-added to the Check In Style.

l Outlook integration on Surface Pro - the Clear backlog and Clear All backlogs buttons are
not visible.
Workaround: change the scale and layout display settings on your system.
o Navigate to Start menu > Settings > System > Display > Scale and Layout > Change

the size of text, apps and other Items and select 125% from the drop down.
o Click Advanced Scaling Settings and turn on the Let Windows try to fix apps so

they're not blurry.
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Thin Outlook Integration

l When a new Appointment item is created in MS Outlook, the Check In on Send and Style
options are not available as an Appointment cannot be sent. If the Appointment is changed to a
Meeting item by adding an attendee, the Content Manager tab options will not be refreshed to
include the Style options.

l The option, Check In on Send, is not available on a Meeting item due to a Microsoft limitation.

l Meeting items are not automatically deleted regardless of the Delete after check in setting on
the Check In Style used.

Content Manager DataPort

l See Content Manager DataPort Help for a list of objects that are supported for import and
export

l Numbering from container - the container must exist in the database before importing the
record that gets its number from the container. If you have an import source that contains both
the container and the record and the record is in either the same batch or an earlier batch than
the container, the batch of records containing that record will not be imported.

l There cannot be hyphens (-) in Thesaurus terms. If you have a Thesaurus that contains terms
with hyphens in them, modify the import file and replace the hyphens with another character
before importing, for example, underscore (_).

l Location associations – DataPort exports associations in a one-way relationship only

l DataPort does not export associated members because Locations of type Organization may
have many thousands of members

l DataPort requires Integrated Windows Authentication (Active Directory) to be enabled as
the dataset authentication method. If the dataset uses Explicit Windows Authentication as
its authentication method, Content Manager DataPort will not work.

Content Manager Enterprise Studio

l When running the Content Manager Workgroup Server as executable file on a computer using
Windows Vista or later, User Account Control (UAC) may cause the message A request to the
Content Manager Workgroup Server <name> failed: Function request <name> for
Content Manager Workgroup Server <name> failed. Failed to setup a shared memory
space for the file <path>. Access is denied. Running as user <name>. and the operation
may fail.

NOTE: Not relevant for normal Content Manager operation, when the Content Manager
Workgroup Server runs as a service, not as executable.

Workaround: Turn off UAC before running the Content Manager Workgroup Server as
executable file.

l Time coordination - the Workgroup Server coordinates date and time details between the client
computers and the Content Manager Servers.
It also prevents Content Manager updates when the clock is more than 10 seconds different.
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This would indicate that someone has manually changed the clock on their local computer while
logged into Content Manager. If this is the case, they will need to log out and then log back in
again to re-synchronize with the network clock.
If your system clock date does not match the server date, your Workgroup Server access will be
denied.
Manually changing the time on the Workgroup Server causes it to stop processing events.

l Enterprise Studio does not report that the IDOL content index is full.

l The Content Manager Workgroup Server throws an error if TLS 1.3 is exclusively enabled for
Microsoft Windows Server 2022 (618147).

Content Manager Mobile App

l Record Property (Add property), adding and removing a record properties is not working as
expected (681046).

l User is redirected to Microsoft login screen, after completing the sharing process on Mobile App
(Android only) (650073).

Content Manager Image Scanner

l Content Manager Image Scanner applies the last used scan settings by default, regardless of
the settings in any third-party scanning applications. This behavior is by design and consistent
with other professional business applications.

Content Manager Render

l When you attempt to use rendering on a file and a dialog box appears in the file’s authoring
application, for example, asking for user details, rendering may fail.
Workaround: Open the authoring application and answer the questions in the dialog before
using it with Content Manager Render.

l Rendering of .chm files to redactable or long-term renditions is not supported

l Rendering may fail with the error message Failed to render document. Print job cancelled.
when the value for the setting Timeout Waiting for Result is too low, as rendering of some file
types may take longer.
Workaround: In Content Manager Enterprise Studio, right click on the affected dataset, point to
Event Processing and click Rendering. The Configure Rendering dialog will appear. Click
the Settings tab and set the Timeout Waiting for Result value to 180-300. Save and Deploy
the configuration file, and then restart the Content Manager Workgroup Service.

l Printing a VMBX file converts the file to a HTML file and then attempts to print the HTML file. To
be able to render a VMBX file, you must have an application registered to handle printing HTML
files.

l Known issue: Rendering a MSG file to PDF or TIFF may fail with the error message Print job
did not start with in the expected time interval.
Workaround: Ensure that Outlook is not installed on the Render processing machine.
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l Known issue: When printing or Rendering an Excel spreadsheet from Content Manager only
the first sheet will be printed/rendered. This may be an issue if you want a representation of the
whole document, such as a Long Term Storage rendition. This is the default behavior when
printing an Excel document fromWindows Explorer.
Workaround: see Setting Printing defaults for Excel Spreadsheets to enable them to be
rendered for a workaround. Please note, this workaround will affect printing Excel spreadsheets
fromWindows Explorer.

Content Manager Web Client

l Web Client supports drag and drop of .msg file either directly from Outlook or from the desktop.
However, the functionality is limited to Chrome and Microsoft Edge browsers.

l When searching for records by using a phrase that contains special characters like parentheses
like [( )] or colons (:), you need to leave them out in the case of the parentheses, or escape them
by using double inverted commas around the entire phrase in the case of a colon.
Examples: To search for a record with the title Report (2007) or Report [2007], use: title: report
2007 To search for a record with the title report: 2007, use: title: “report: 2007”

l During the record creation process, when a MSG file is attached or dragged onto the record
entry form, the Date Created field is removed from the form. This is due to a technical limitation
that prevents client side applications from extracting date related metadata, such as the Date
Created, from a MSG file. However, when the file is sent to the server and finally attached to the
newly created record in Content Manager, the date related metadata (Date Created) can be
extracted and is appropriately specified on the record.

l Due to the requirement to have Automatic Logon with current user name and password
authentication enabled, the WebDAV Check out and edit option does not support Guest
account access to the Content Manager Web Client. All users must have a valid Windows
Domain account that can automatically authenticate to the Web Server.

l When searching for Content objects by a Date search method using the Web Client, there is no
client side validation done on the field. This is to allow for more flexible search options such as
This Year, Last Week, Today. If a user types in invalid values into a Date search method,
Content Manager will try to retrieve the objects based on the entered values.
Workaround: Use the Calendar option to select a correctly defined date format.

l The Check out and edit option, which uses WebDAV, is not supported when some form of
load balancing is employed to distribute requests between multiple instances of the Web Client
running on different machines.
The WebDAV feature stores the user's working copies in a WebDAV share located on the Web
Server at URL /CMWebDAV/DAVDir/ and all requests made to that URL must resolve to the
sameWebDAV share on the same physical machine so that the user can save their work
temporarily and resume editing it before committing changes. This cannot be guaranteed when
using a load balancing configuration.

l TheWebDAV Check out and edit option does not work when using ADFS for Web Client
Authentication. The WebDAV implementation in IIS relies uponWindows Authentication to
identify the user and does not have the ability to forward authentication requests to ADFS to
determine the user's identity. If you are using ADFS for Web Client Authentication, do not
configure the WebDAV Check out and edit feature as described in CM23.3_WebClient.pdf
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l If Reference files (.TR5 files) that included aWeb Client Classic link as the WebURL were
generated in TRIM/Records Manager versions 7.3x or 8.1x, these WebURLs will not open in
the Web Client after upgrading to 9.0x or above versions. A similar issue applies to Reference
files that included aWebDrawer link as the WebURL in TRIM/Records Manager versions 7.3x
or 8.1x, these WebURLs will not open in WebDrawer after upgrading to 8.2 or above versions
These limitations are due to the changes in the structure of the WebURLs, and the
obsolescence of Web Client Classic.

l The requestFiltering doesn't allow more than 2GBmaxAllowedContentLength, this leaves the
upper limit of file upload to 2GB. Since this value is constraint by ASP.NET, the size of DOS file
upload in the Web Client should be less than or equal to 2GB. For more information, please
see: https://blogs.msdn.microsoft.com/friis/2013/06/19/uploading-large-file-to-iis-7-5-or-8-
using-file-input-element/

Content Manager WebDrawer

When copying and pasting a URL fromWebDrawer, or the Web Client, into an Office 2013 or lower
version application, an error will occur when clicking the hyperlink in Office due to a known Microsoft
limitation.

Workaround:

Apply the fix described in

https://support.microsoft.com/en-au/help/218153/error-message-when-clicking-hyperlink-in-office-
cannot-locate-the-inte

Content Manager Workflow

l A sub-process must have at least two sub-Activities. When there is just one Activity, Content
Manager deletes the Activity and the sub-process.

l When aWorkflow template that includes document placeholders is exported from, and
imported into, a Content Manager dataset, the document placeholders are not transferred. The
required document placeholders will need to be manually added to the Workflow template after
it has been imported.

l When you open aWorkflow in the Workflow editor and close it without making any changes to
the Workflow, the Content Manager displays Save dialog asking whether you want to save the
changes to your workflow.

Content Manager for SharePoint Integration

Columns that use custom behavior

The following only affects an on-premise installation of SharePoint 2013, 2016 and 2019, it does not
apply to SharePoint Online.

If the following error is seen while trying to select a new value for one of the Integration columns:
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Then either refresh the browser page or de-activate theMinimal Download Strategy feature at Site
Settings > Manage Site features:

Content Manager for IDOL

Content Manager security options for IDOL with OGS

The following security options are not implemented in the IDOL/OGS security mapping:

l Access exclusions on records;

l Referenced access exclusions on classifications and record types;
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l Access controls inherited from client and matter records;

l The “inherited from container + in record access control list” option.

To avoid timeouts with complex group hierarchies, manually install IDOL SecurityKeys
stored procedure

To manually install the stored procedure, follow the steps:

1. Right-click on the dataset where you want to install the stored procedure.

2. Navigate to Schema > Manage. The Schema Manager dialog is displayed.

3. In the left pane, expand Procedures and scroll down to ConstructSecurityKey procedure.

4. Right-click > Check and then Recreate.

The stored procedure is installed for the dataset.

5. Click Close to exit out of Schema Manager.

Key limits

Data storage

NOTE: The following entities are a subset. The subset includes those key to Content Manager
operations and most frequently of interest. Further details can be provided on request.
The number of records you can have in Content Manager is mostly limited by the RDBMS system
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you are using.

* Recommended, but not strictly enforced upper limit. Beyond this limit, Content Manager has not
been tested extensively and may be subject to performance degradation.

Entity Limit

Record Types 1024 *

Record parts 99 *

Records in container 300 *

Security levels 99

Caveats 512

External links 20

Advanced search lines 20 *

Offline Records documents 500 * per user per dataset

Offline Records folders 60 *

Versions 99 *

Decimals and currency A maximum of 15 digits before the decimal
place, up to 8 decimal places

Edit box drop-down history A minimum of 10 and maximum of 500, default
is 25.

Recent Containers and Recent Documents 25

Document content index database 10 million documents per IDOL content index
server (5 million recommended)

Field length

Entity Character limit

Record Number 50

Record Type Name 50

Part Numbers 2

Foreign Barcode 30

This entity supports multiple barcodes that can be
upto 30 characters each separated by a semicolon
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(;).

Record Title (structured text) 1024

Record Title (free text) 1024

Thesaurus Term 100

Classification Plan number 10

Classification Plan level name 260

Security Level Name 50

Security Caveat Name 50

Person Surname 100

Organization Name 200

Group Name 200

Position Name 200

Location Telephone Number 30

Location Email Address 255

Person Initials 25

Logs in as (user name plus domain name) 255

Entity Character limit

Notes 65536

External reference 50

Workflow Name 512

Workflow Activity Name 100

Retention Schedule title 200

Retention Schedule number 30

Consignment number 50

Priority 5

Additional text Field 65535

Lookup Set name 50
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Lookup Set items 1024 *

Index word 50
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